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U.S. Environmental Protection Agency’s 
Preferred Regulatory Model
AERMOD is the state-of-the-science, steady-state Gaussian 
air dispersion model that is U.S. EPA-approved for most refined 
modeling scenarios. BREEZE AERMOD is an enhanced version of 
the U.S. EPA-approved AERMOD that provides modelers with the 
tools and functionality required to perform air quality analyses 
that help to address permitting, regulatory, and nuisance issues, 
perform academic research, and assist companies worldwide 
with capital planning. BREEZE AERMOD offers the most complete 
air quality modeling system available on the market today. No 
other application is used by more air quality professionals 
around the world.

Software Overview
BREEZE AERMOD is a world-renowned air dispersion modeling 
program that incorporates the unmodified U.S. EPA AERMOD 
executable, while also providing users with a wealth of additional 
tools and capabilities. In addition to including all of the standard 
U.S. EPA source types and features, BREEZE AERMOD includes 
exclusive BREEZE features such as a flare source type, the ability to 
model multiple pollutants at the same time, and much more.

The purchase of BREEZE AERMOD also includes BREEZE 3D Analyst, 
which provides users with many ways to visualize and analyze 
results. From creating contour maps showing the concentrations 
overlaid on a basemap, to creating animations of results, to 
utilizing the many data manipulation tools within 3D Analyst to 
easily and quickly conduct tasks such as extracting exceedance 
counts, 3D Analyst makes analyzing modeling results a breeze! 

BREEZE AERMOD is available in two editions: Pro and Pro Plus. 
BREEZE AERMOD Pro Plus includes all of the features of the 
Pro edition, as well as additional features such as the ability 
to create animations, export results as shapefiles, and use 
additional source contribution analysis tools. Details about 

the differences between these two editions can be found in 
the BREEZE AERMOD Editions and Pricing and What’s Included 
sections of this brochure.

ISC Model
In December 2006, AERMOD replaced the Industrial Source 
Complex (ISC) short-term model as the U.S. EPA recommended 
regulatory model. However, ISC is still widely used internationally 
so the BREEZE AERMOD suite conveniently includes ISC. ISC 
predicts pollutant concentrations from nearly any type of 
source emitting non-reactive pollutants. It allows you to define 
receptor grids and consider topographical features for each 
receptor location. You are also able to input above ground-
level heights to simulate the impact at elevated or “flagpole” 
receptors. BREEZE ISC also predicts pollutant concentrations 
from: point, line, area, volume, and flare sources with variable 
emissions in all terrain regimes. 

Product Features and Tools
BREEZE AERMOD includes a wealth of features and tools that 
facilitate the model setup and results analysis process by 
expediting the model run setup, facilitating file management, 
and improving results display and post-processing capabilities. 
These tools are available free of charge to BREEZE AERMOD 
users and are conveniently integrated and accessed through 
the BREEZE AERMOD interface, making it easier than ever to 
setup, run, and analyze a dispersion modeling assessment. The 
following are only some of these features and tools:

Basic Features

 f Includes the latest U.S. EPA AERMOD executable and 
U.S. EPA BPIPPRM executable

 f Preserves compatibility with previous U.S. EPA AERMOD 
versions, back to executable 07026

BREEZE AERMOD/ISC

http://www.trinityconsultants.com/software/air-dispersion---data-visualization/3D-analyst
https://www.epa.gov/scram/air-quality-dispersion-modeling-preferred-and-recommended-models#aermod
https://www.epa.gov/scram/air-quality-dispersion-modeling-related-model-support-programs#drft-bpipprm
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Powerful Model  
Setup and Post-
Processing Tools

 f Data Tab that provides a 
means of viewing project 
data in a spreadsheet 
view, allowing users to 
copy and paste directly 
from Excel, sort data, 
change model IDs,  
and filter objects by  
data types 

 f Map Tab which allows 
users to import DXF files, 
shapefiles, and base 
map images as well as 
visualize and graphically 
edit model objects

 f The ability to download high-resolution base maps 
for any location in the world by simply entering the 
desired coordinates 

 f The post-processing program BREEZE 3D Analyst, which is 
used to make graphical displays of AERMOD results

 f The basic version of BREEZE MetView and the basic, 
merge-only version of BREEZE AERMET

 f XYZ2DEM tool to convert XYZ terrain files to digital elevation 
model (DEM) format

 f Coordinate Converter to convert model coordinates between 
hundreds of coordinate systems

 f SAMSON Conversion Tool that enables users to convert 
surface meteorological data to a SAMSON file format, which 
can then be used to process AERMOD-ready meteorological 
data using AERMET

 f Hourly Emission File Editor to create, view, and edit hourly 
emission rate files for modeled sources

 f Ozone file, hourly emission file, and AERMOD input file editors
 f Tool to import model objects from existing BREEZE AERMOD 

scenarios or other commercial/non-commercial AERMOD 
scenarios, thereby expediting the model setup process

 f Export tool to export model objects to DXF files
 f 3D window to view buildings and terrain
 f Delete On-Site or Off-Site Receptors tool to quickly remove all 

onsite or offsite receptors, depending on the modelers needs
 f Variable Density Grid, Polygon Grid, and other drawing tools to 

quickly create receptor grids and other model objects

 f Includes a basic, merge-only version of BREEZE AERMET and 
a basic version of BREEZE MetView with the purchase

 f Includes a streamlined graphical user interface for more 
intuitive and easier dispersion modeling

 f Generates an aligned or geo-referenced file after manually 
importing a basemap and geo-referencing it

 f Imports 2D and 3D geometric data with AutoCAD’s .dwg/dxf 
file formats

 f Simplifies the setup of pre-modeling objects with a variety 
of utilities

 f Analyzes modeling results using BREEZE 3D Analyst, tables 
for sensitive receptors, and 3D visuals for surface terrain

 f Organizes model scenarios using a skeleton and neat file 
structure for better file management

 f Uses inputs that are consistent and compatible with U.S. 
EPA AERMOD inputs, including test cases from the U.S. EPA 
SCRAM website

Technical Features

 f Streamlines NO2, SO2 and PM2.5 modeling for U.S. NAAQS
 f Adds a feature to allow applying an in-stack NO2/NOX ratio to 

multiple sources all at once for all source types
 f Incorporates the Ambient Ratio Method (ARM) and ARM2 for 

NO2 modeling
 f Adds a new tool to facilitate users to calculate buoyancy 

parameters for buoyant line sources
 f Models an unlimited number of sources and receptors
 f Models numerous source types including point/stack 

(vertical, horizontal and capped), area, circular area, 
polygon area, volume, open pit, flare, BREEZE area line, 
U.S. EPA area line, RLINE Roadway, RLINEXT Roadway, and 
Buoyant line

 f Models numerous receptor types including discrete Cartesian 
grid, polar grid, and variable density grid

 f Models multiple emission scenarios simultaneously
 f Models an unlimited number of buildings with integrated 

BPIP analysis and downwash
 f Utilizes CAD drawing tools
 f Supports 7.5 DEM, 1-minute DEM, XYZ, and NED terrain 

data files
 f Uses historical, hourly meteorological data with single or 

multiple hours (available for purchase separately) 
 f Includes the ISC model
 f Includes BREEZE AERMOD Parallel 2-CPU, and users have 

the ability to purchase additional cores as desired
 f Includes seamless integration with the BREEZE Remote 

Modeling System (available for purchase separately) 

http://www.trinityconsultants.com/software/air-dispersion---data-visualization/3d-analyst
http://www.trinityconsultants.com/software/air-dispersion---data-visualization/metview
http://www.trinityconsultants.com/software/dispersion/aermet
http://www.trinityconsultants.com/software/dispersion/aermet
http://www.trinityconsultants.com/software/air-dispersion---data-visualization/metview
http://www.trinityconsultants.com/software/air-dispersion---data-visualization/3d-analyst
http://www.trinityconsultants.com/software/high-speed-modeling-services/standard-computing
http://www.trinityconsultants.com/software/high-speed-modeling-services/standard-computing
http://www.trinityconsultants.com/software/high-speed-modeling-services/cluster-computing
http://www.trinityconsultants.com/software/high-speed-modeling-services/cluster-computing
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 f U.S. EPA BPIP Prime program integration to automatically 
process building information 

 f Source grouping tools to quickly assign source groups
 f And more! 

Streamlined Data Entry
User-Friendly Interface
The intuitive and user-friendly interface of BREEZE AERMOD is 
designed similar to Microsoft® software interfaces. As a result 
BREEZE AERMOD seamlessly guides users through setting up 
their modeling scenarios in a quick and efficient manner, saving 
users time and money. The interface also provides modelers 
with several options for entering data, allowing modelers to 
choose the option that works best for them thereby further 
streamlining the model setup process. Furthermore, the interface 
alerts users of potential issues that might affect their model 
run. On the Project Tab, error messages (which will prevent 
AERMOD from running), warning messages, and informational 
messages appear to let the user know what potential issues 
might exist during the model setup so they can resolve them. 
The user can simply double click on the message line item in 
the interface and BREEZE AERMOD will take them directly to the 
window where they can look into the matter and resolve it if 
needed. This unique feature serves as a convenient QA/QC step 
during the model setup and saves users time and money. 

Meteorology
Assigning model-ready meteorological data in BREEZE AERMOD 
is easy. Simply select the files to use with a particular scenario. 
BREEZE AERMOD will automatically identify the period that the 
data set is valid for and display the station ID so that there are 
no mistakes setting up the input file.

A number of options are available in BREEZE AERMOD to refine the 
period of meteorological data to process in the model run, such 
as ‘Start/End period’ option, ‘Day range’ option, and ‘All hours’ 
option, so users do not need to split the meteorological files when 
performing modeling for a particular period.

For users who want to create wind roses or view the AERMOD-
ready meteorological data in a tabular view, the basic version 
of BREEZE MetView is included with every BREEZE AERMOD 
purchase and can be seamlessly accessed from the BREEZE 
AERMOD interface. The basic version can be used to display 
the model-ready meteorological data in both tabular and chart 

format and enables users to create wind roses for user-defined 
periods, allowing users to simultaneously view and interpret 
model results using corresponding meteorological data. For 
more information about BREEZE MetView, please click here. 

Note: Model-ready meteorological data for AERMOD is not 
included with the purchase of BREEZE AERMOD. Users can 
either process the data on their own, or purchase model-ready 
meteorological data from our Data Team.

Sources
BREEZE AERMOD allows users to model the standard U.S. EPA 
sources (i.e., point, area, volume, open pit, U.S. EPA area line, RLINE 
roadway, RLINEXT roadway, Buoyant line) and exclusive BREEZE 
sources such as flare and BREEZE area line sources. In addition, 
BREEZE offers object array generators that create user-defined 
arrays (e.g., polylines, polygons, and Cartesian grids) of the model 
object type. Another perk of the BREEZE-enhanced version - it 
enables users to model multiple emission scenarios in the same 
amount of time it takes to model a single pollutant! The U.S. EPA 
AERMAP program is also seamlessly embedded within BREEZE 
AERMOD so source elevations can be processed with the simply 
click of the mouse.

Multiple Methods to Add Sources
BREEZE AERMOD provides users with multiple ways to enter source 
data making it easier than ever to setup a model run scenario: 

 f Project Tab: Users can manually enter source data one source 
at a time. 

 f Data Tab: Users can use this spreadsheet style tab to 
manually enter the source data, or copy and paste the data 
from an Excel file. The columns in this tab can be easily 
moved and units can be changed to match the layout and 
format of the data in the Excel spreadsheet that the user is 
copying from. 

 f Map Tab: This tab is a true Geographic Information System 
(GIS) that displays model objects and maps in a user-
specified projection and datum. Using this tab, modelers can 
add the source(s) by placing them at the correct coordinate 
location, or by using a basemap as a guide and placing them 
where they should be with respect to the basemap. 

Flare Sources
BREEZE AERMOD processes flare sources as equivalent point 
sources according to U.S. EPA modeling guidance. It calculates 
the equivalent source diameter internally according to user 
defined parameters, such as hear release, radiation loss, and 
exit velocity. More information about this can be found in the 
BREEZE AERMOD user manual. If you have any questions before 
making your purchase though, please contact our Support Team 
at support@trinityconsultants.com or +1 972.661.8881 option 4. 

http://www.trinityconsultants.com/software/air-dispersion---data-visualization/metview
http://www.trinityconsultants.com/software/air-dispersion---data-visualization/metview
http://www.trinityconsultants.com/software/high-speed-modeling-services/model-ready-data
http://www.trinityconsultants.com/software/high-speed-modeling-services/model-ready-data
http://www.epa.gov/scram001/guidanceindex.htm
mailto:support@trinityconsultants.com
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Buildings
AERMOD takes into account the obstruction of wind flow from 
structures, such as buildings and point sources (i.e., stacks), so 
including nearby buildings in an AERMOD modeling scenario 
is an important step when setting up the model run. BREEZE 
AERMOD offers users the ability to add rectangular, circular, and 
polygon buildings in a variety of ways. Like any other model 
object in BREEZE AERMOD, buildings can be manually entered in 
the Project Tab, copied and pasted into the Data Tab, or drawn 
into the 2D display using the Map Tab. A simple building mode 
is an exclusive feature of BREEZE AERMOD that eliminates the 
error prone requirement of assigning “tier levels” to each and 
every structure. Additionally, building information can be easily 
processed with the embedded U.S. EPA BPIP Prime program, 
and the building elevations can be quickly processed using the 
embedded U.S. EPA AERMAP program. 

BREEZE Downwash Analyst
BREEZE Downwash Analyst is a companion program to BREEZE 
AERMOD (available for purchase separately) that takes the cryptic 
numerical results of AERMOD’s BPIP building pre-processor and 
displays them in the clearest way possible. BREEZE Downwash 
Analyst takes the mystery out of building downwash and gives 
you a deeper understanding of your model results, making 
it an essential tool for any serious AERMOD user. For more 
information about BREEZE Downwash Analyst, please click here. 

Receptors
Receptors are locations where BREEZE AERMOD will compute a 
concentration or deposition value. At least one receptor must 
be defined in order to run the AERMOD model, and BREEZE 
AERMOD allows users to enter the receptors in several different 
ways, from entering the data manually one at a time in the Project 
Tab, to copying and pasting data from a spreadsheet into the Data 
Tab, to placing the receptors directly where they’re located on a 
base map in the Map Tab. BREEZE AERMOD also provides users 
with the ability to create discrete, gridded, and polygon arrays of 
receptors, as well as variable density and 3D gridded networks. 
Receptor elevations can be quickly processed using the U.S. EPA 
AERMAP program which is conveniently embedded in the BREEZE 
AERMOD interface. 

High-Speed Parallel Processing Solutions
To combat the increased runtimes observed with US EPA’s AERMOD, 
we created a parallel processing version to slash runtimes through 
the use of a distributed computer network (cluster) or multi-
CPU environment. Our high performance applications produce 
pollutant concentration estimates identical to U.S. EPA’s Fortran 
executable. The only code changes to the application are additions 
to implement parallel features. The applications run the exact 
algorithms but on multiple different processors. 

There are two high-speed solutions available for BREEZE 
AERMOD users who are interested in parallel processing: local 
and remote resources. Note: A two-core local parallel processing 
version is included with the purchase of BREEZE AERMOD.

 f Local: The local approach involves purchasing BREEZE 
AERMOD Parallel and determining how many processors 
are desired to run the software application. Improvements 
in the product’s performance enhancements are based 
directly on the number of CPUs (or cores) utilized. 

 f Remote: Alternatively, the BREEZE Remote Modeling System 
requires no proprietary software and runs on a massively 
parallel computer cluster managed by BREEZE Software. 
Users upload input files anytime (24/7), receive email 
notifications when model results are completed, and slash 
model runtimes. Runs that would take weeks on a single-
core computer are typically completed in days, and runs 
that would take hours are typically completed in minutes 
using the BREEZE Remote Modeling System.

Trinity developed AERMOD Parallel to significantly improve 
performance across multiple processors. As part of the product 
development process, equivalency testing was performed with 
hundreds of AERMOD model runs using both the AERMOD Fortran 
executable and the BREEZE AERMOD Parallel executables. Based 

http://www.trinityconsultants.com/software/air-dispersion---data-visualization/downwash-analyst
http://www.trinityconsultants.com/software/air-dispersion---data-visualization/downwash-analyst
http://www.trinityconsultants.com/software/high-speed-modeling-services/model-ready-data
http://www.trinityconsultants.com/software/high-speed-modeling-services/model-ready-data
http://www.trinityconsultants.com/software/high-speed-modeling-services/standard-computing
http://www.trinityconsultants.com/software/high-speed-modeling-services/standard-computing
http://www.trinityconsultants.com/software/high-speed-modeling-services/cluster-computing
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on all completed test cases, modeling results generated by the 
BREEZE AERMOD Parallel are identical to those generated by the 
U.S. EPA AERMOD executables. 

BREEZE AERMOD Editions
BREEZE AERMOD is available for purchase as two editions – Pro 
and Pro Plus. Both editions incorporate the latest U.S. EPA AERMOD 
executable as well as the ISC model, preserve back-compatibility 
with previous model versions, enable users to download 
high-resolution base maps for any location around the world, 
integrate 3D Analyst for post-processing model results, and 
more. The main differences between these editions come down 
to the post-processing capabilities. For example, while both 
editions enable users to display graphical results overlaid on a 
basemap using 3D Analyst, only users with the Pro Plus edition 
have the ability to utilize the distribution view and contribution 
view (which enable users to determine the distribution and 
contribution of each source over a given time period) and create 
a variety of animations (e.g., map, 3D, cross-section, contribution 
chart, distribution chart, and Google Earth contour animation). 
Download the table to compare the features available in BREEZE 
AERMOD Pro and Pro Plus.

Product Features of Both Editions

 f Incorporates the latest U.S. EPA AERMOD executable
 f Incorporates the ISC model
 f Preserves compatibility with U.S. EPA AERMOD versions back 

to executable 07026
 f Enables users to download or import high-resolution base 

maps for any location around the world
 f Enables converting imported DWG/DXF objects to AERMOD 

model objects and buildings
 f Integrates with the BREEZE 3D Analyst post-processing 

program to provide users with a wealth of post-processing 
options

 f Employs a streamlined graphical user interface for more 
intuitive and easier dispersion modeling

 f Models an unlimited number of sources, source types, 
and receptors

Pricing and What’s Included
The prices below are for the purchase of a single license. We offer 
a multiple license discount if you purchase multiple licenses 
of one edition within the same transaction. Additionally, if you 
don’t expect to use the software long-term, we offer 1-, 3-, 6-, and 
9-month leasing options. 

Contact us at breeze@trinityconsultants.com or +1 972.661.8881 
for lease pricing details. 

AERMOD Pro

BREEZE AERMOD Pro is loaded with features to optimize your 
modeling. The intuitive user interface is extremely easy to learn 
and understand, and guides users through the model setup and 
analyzing results. With BREEZE AERMOD Pro, users have access 
to a variety of displays (e.g., 3D view, Map view, etc.), data entry 
options (e.g., importing a base map, copying and pasting to a 
table from Excel, CAD drawing tools), data processing options, 
model outputs, and plotting and data manipulation/analysis 
tools. Additionally, significant effort has gone into giving users the 
option to hide many of the data entry options that they might not 
require. For example, if you are not modeling deposition, you can 
choose not to show the data entry options related to deposition. 
These advanced features included in BREEZE AERMOD Pro are very 
beneficial for new and seasoned users and increase productivity 
by adapting to the users preferences and workflow.

What’s Included?

 f Both the AERMOD and ISC models
 f BREEZE 3D Analyst for post-processing and graphical 

displays of results
 f Basic version of BREEZE MetView
 f Basic, merge-only version of BREEZE AERMET
 f Ability for parallel processing using two cores
 f Complimentary 10-day trial period to the high-speed 

remote modeling system
 f A perpetual license of the software
 f One free year of technical support and maintenance 

(upgrades) for the registered user

AERMOD Pro Plus

BREEZE AERMOD Pro Plus includes all of the features of the 
Pro edition, as well as a handful of additional features mainly 
pertaining to data manipulation/analysis and animation 
graphics. For example, BREEZE AERMOD Pro Plus provides users 
with a distribution view and a contribution view option, which 
users can utilize to determine the distribution and contribution 
of each source over a given time period. Additionally, with 
BREEZE AERMOD Pro Plus, users have the ability to create a 
variety of animations (e.g., map, 3D, cross-section, contribution 
chart, distribution chart, and Google Earth contour animation) 
that they would not have access to with the Pro edition. These 
animations are great visual tools when presenting results to 
colleagues or clients. To see the full advantages of purchasing 
BREEZE AERMOD Pro Plus, click here to compare the features in 
the two editions.

https://www.breeze-software.com/Support/Library/Documents/BREEZE-AERMOD-Pro-and-Pro-Plus-Editions-Comparison-Table/
http://www.trinityconsultants.com/software/air-dispersion---data-visualization/3d-analyst
mailto:breeze@trinityconsultants.com
http://www.trinityconsultants.com/software/air-dispersion---data-visualization/3d-analyst
http://www.trinityconsultants.com/software/air-dispersion---data-visualization/metview
http://www.trinityconsultants.com/software/dispersion/aermet
http://www.trinityconsultants.com/software/high-speed-modeling-services/cluster-computing
http://www.trinityconsultants.com/software/high-speed-modeling-services/cluster-computing
https://www.breeze-software.com/Support/Library/Documents/BREEZE-AERMOD-Pro-and-Pro-Plus-Editions-Comparison-Table/
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What’s Included?

 f Both the AERMOD and ISC models
 f BREEZE 3D Analyst for post-processing and 

graphical displays of results
 f Full version of BREEZE MetView
 f Basic, merge-only version of BREEZE AERMET
 f Complimentary 30-day trial period to the high-speed 

remote modeling system
 f A perpetual license of the software
 f One free year of technical support and maintenance 

(upgrades) for the registered user
 f One free license of BREEZE Downwash Analyst
 f One free license of BREEZE AERMOD Parallel 8-CPU
 f A 1-2 hour “getting started” training recording

Related Products and Services

 f BREEZE MetView
 f BREEZE Downwash Analyst
 f BREEZE AERMET
 f BREEZE AERSCREEN
 f AERMOD-Ready Meteorological Data
 f High-Speed Modeling Solutions
 f Specialized Consulting Services
 f Training

All trademarks are the property of their respective owners.

http://www.trinityconsultants.com/software/air-dispersion---data-visualization/3d-analyst
http://www.trinityconsultants.com/software/air-dispersion---data-visualization/metview
http://www.trinityconsultants.com/software/dispersion/aermet
http://www.trinityconsultants.com/software/high-speed-modeling-services/cluster-computing
http://www.trinityconsultants.com/software/high-speed-modeling-services/cluster-computing
https://www.trinityconsultants.com/software/air-dispersion---data-visualization/downwash-analyst
https://www.trinityconsultants.com/software/high-speed-modeling-services/standard-computing
http://www.trinityconsultants.com/software/air-dispersion---data-visualization/downwash-analyst
http://www.trinityconsultants.com/software/dispersion/aermet
http://www.trinityconsultants.com/software/dispersion/aerscreen
http://www.trinityconsultants.com/software/high-speed-modeling-services/model-ready-data
http://www.trinityconsultants.com/software/high-speed-modeling-services
http://www.trinityconsultants.com/software/specialty-modeling-services/air-dispersion-modeling
http://www.trinityconsultants.com/training/software/software-courses
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